
 Unit 5. (Data Modelling) 

Data Analysis Tools: Pivot Tables and Pivot Charts, Data Validation 

(Dropdowns, Input Messages, Error Alerts), What-If Analysis: Goal 

Seek, Scenario Manager, Data Tables Charts and Dashboards: 

Creating Interactive Dashboards, Using slicers with Pivot Tables Combo 

Charts and Sparklines. Productivity Tips: Using Named Ranges, 

Freeze Panes, Split View. 

Data Modelling:- 

Data Modelling is the process of organizing data in a clear and 

structured way so that it can be easily stored, understood, and used in 

a database. 

It shows what data is needed, how the data is related, and how it 

should be stored. Data modelling works like a plan or blueprint 

before creating a database. 

Data modelling helps to: 

• Avoid duplicate data 

• Maintain data accuracy 

• Store data properly 

• Retrieve data easily 

Data Analysis Tools: 

Data Analysis Tools are software tools or features used to collect, 

organize, analyze, and interpret data in order to find useful 

information and make better decisions. 

In simple words, data analysis tools help us understand data by 

summarizing it, comparing it, and showing it in an easy-to-read form. 

Why Data Analysis Tools are Used 

• To analyze large amounts of data easily 

• To find patterns, trends, and results 

• To make correct decisions 

• To present data clearly using charts and reports 

 



Examples of Data Analysis Tools 

• Pivot Tables – Summarize large data quickly 

• Charts and Graphs – Show data visually 

• Data Validation – Controls correct data entry 

• What-If Analysis – Predict results by changing values 

• Dashboards – Display key information on one screen 

 

Conditional Formatting in MS Excel 

Conditional Formatting in MS Excel is a powerful feature used to 

automatically format cells based on certain conditions or 

rules. It helps users highlight important data, identify trends, 

compare values, and detect errors easily. By applying colors, icons, 

or data bars, conditional formatting makes large data sets more visual, 

clear, and easy to analyze. 

1. Custom Rules 

Custom rules allow users to create their own conditions using formulas 

or logical comparisons. These rules are useful when default options are 

not sufficient. 

• User-defined conditions 

• Uses formulas like >, <, =, IF 

• Highlights specific data 

• Helps find errors or exceptions 

• Flexible and powerful 

Example: 

Highlight marks below 35 in red. 

2. Color Scales 

Color Scales apply different colors to cells based on their values. They 

show data variation using a gradient of colors. 

• Uses color gradients 

• Highlights high and low values 



• Easy to identify trends 

• Automatically adjusts colors 

• Common in marks and sales analysis 

Example: 

Green for highest marks, red for lowest. 

3. Icon Sets 

Icon Sets display symbols like arrows, stars, or traffic lights to 

represent values visually. 

• Uses icons instead of numbers 

• Shows performance levels 

• Easy visual comparison 

• Useful in dashboards 

• Improves decision making 

Example: 

Green arrow = good performance 

Red arrow = poor performance 

4. Data Bars 

Data Bars add horizontal bars inside cells based on cell values. The 

bar length represents the value size. 

• Shows values graphically 

• Longer bar = higher value 

• Works within cells 

• Easy to compare data 

• Saves space 

Example: 

Sales report with bar length showing sales amount. 

Pivot Tables :- 

A Pivot Table is a powerful data analysis tool used in spreadsheet 

applications like MS Excel to summarize, analyze, and organize 

large amounts of data quickly and easily. 



It allows users to rearrange (pivot) data by dragging and dropping fields 

into rows, columns, values, and filters. Pivot tables can automatically 

perform calculations such as sum, average, count, minimum, and 

maximum. 

Pivot tables help in identifying patterns, trends, and comparisons 

in data without using complex formulas. They are widely used in 

business, education, and research for data analysis and reporting. 

How to Use a Pivot Table  

Step 1: Prepare Data 

• Enter data in rows and columns 

• Each column must have a heading 

• No empty rows or columns 

Step 2: Select the Data 

• Click on any cell inside the data table 

• Or select the entire data range 

Step 3: Insert Pivot Table 

• Go to Insert tab 

• Click Pivot Table 

• Choose From Table/Range 

• Click OK 

Step 4: Arrange Fields 

You will see Pivot Table Fields panel: 

• Drag Student → Rows 

• Drag Subject → Columns 

• Drag Marks → Values 

Excel will automatically show total marks. 

Step 5: Analyze Data 

• Use Filters to view specific data 

• Change calculations (Sum → Average, Count) 

• Create Pivot Charts for visualization 



Pivot Charts:- 

A Pivot Chart is a graphical representation of a Pivot Table. It is 

used to visualize summarized data in the form of charts like column, 

bar, line, or pie charts. 

In simple words, pivot charts show pivot table data in picture 

form, making it easy to understand and compare. 

Why Pivot Charts are Used 

• To understand data visually 

• To compare values easily 

• To identify trends and patterns 

• To make reports more attractive 

• Pivot charts help present pivot table data in graphical form for 
better understanding and analysis. 

Types of Pivot Charts 

• Column Chart 

• Bar Chart 

• Line Chart 

• Pie Chart 

• Area Chart 

How to Create a Pivot Chart:- 

Step 1: Prepare Data 

Make sure your data is in table format with headings. 

Step 2: Create a Pivot Table 

1. Select any cell in the data 

2. Go to Insert → Pivot Table 

3. Click OK 

Step 3: Arrange Pivot Table Fields 

• Drag Student → Rows 

• Drag Subject → Columns 



• Drag Marks → Values 

Now the pivot table is ready. 

Step 4: Insert Pivot Chart 

1. Click anywhere inside the Pivot Table 

2. Go to Insert → Pivot Chart 

3. Choose chart type (Column / Bar / Line / Pie) 

4. Click OK 

 

Step 5: Customize the Pivot Chart 

• Add Chart Title 

• Use Filters or Slicers 

• Change chart type if needed 

• Resize and format the chart 

 

Data Validation:- 

Data Validation is a feature in MS Excel that controls what type 

of data can be entered into a cell. 

It ensures that the data entered is correct, valid, and follows 

specific rules, helping to avoid mistakes and errors in 

spreadsheets. 

Why is Data Validation Important? 

• Prevents wrong data entry 

• Maintains data accuracy and consistency 

• Saves time by reducing corrections 

• Helps in creating dropdown lists for easier data entry 

• Useful for data analysis and reporting 

 

 

 



Types of Data Validation in MS Excel  

Data Validation in Excel allows you to control what type of data can be 

entered into a cell. There are 7 main types: 

1. Whole Number 

• What it does: Allows only integer numbers in a cell. 

• Where to use: Marks, student IDs, quantity of items. 

• Example: Enter marks between 0 and 100. 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Whole Number 

3. Set Minimum = 0, Maximum = 100 

Now, entering 105 or -5 will show an error. 

2. Decimal 

• What it does: Allows decimal numbers (with fractions). 

• Where to use: Prices, percentages, measurements. 

• Example: Product price must be between 10.5 and 999.9 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Decimal 

3. Set Minimum = 10.5, Maximum = 999.9 

3. List 

• What it does: Creates a dropdown list of allowed values. 

• Where to use: Subjects, departments, yes/no options. 

• Example: Subjects = Python, Java, Django 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → List 

3. Source → Python, Java, Django 



 Users can only select from the list, not type other values. 

4. Date 

• What it does: Allows only dates within a specified range. 

• Where to use: Admission dates, joining dates, deadlines. 

• Example: Admission date must be between 01-01-2025 and 31-

12-2025 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Date 

3. Start date = 01-01-2025, End date = 31-12-2025 

5. Time 

• What it does: Allows only time entries within a specific range. 

• Where to use: Class schedules, office hours, appointment 

timings. 

• Example: Class time between 09:00 AM and 05:00 PM 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Time 

3. Start time = 09:00, End time = 17:00 

6. Text Length 

• What it does: Restricts the number of characters entered in a 

cell. 

• Where to use: Student IDs, phone numbers, codes. 

• Example: Student ID must be exactly 5 digits 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Text Length 

3. Equal to = 5 



Entering more or less than 5 characters will show an error. 

7. Custom 

• What it does: Allows you to create a custom rule using 

formulas. 

• Where to use: Advanced validations based on conditions. 

• Example: Only even numbers allowed → Formula: 

=MOD(A1,2)=0 

• Steps: 

1. Select cell → Data → Data Validation 

2. Allow → Custom 

3. Formula → =MOD(A1,2)=0 

What-If Analysis  

What-If Analysis in Excel helps you explore how changing input values 

affects formula outcomes, using tools like Scenarios (named sets of 

inputs for multiple variables), Data Tables (one or two variables across 

many values), and Goal Seek (finding an input for a specific result) to 

test possibilities without altering original data, ideal for budgeting, 

forecasting, and decision-making.  

Why is What-If Analysis Used? 

What-If Analysis is used to: 

• Predict future results 

• Compare different possibilities 

• Make better decisions 

• Analyze best-case, worst-case, and average situations 

• Understand how input values affect output 

Types of What-If Analysis in MS Excel 

There are three main types of What-If Analysis: 

1.Goal Seek 

Goal Seek is used when you know the final result, but you want to 

find the input value required to achieve that result. 

https://www.google.com/search?sourceid=chrome&nseg=what+if+analysis+in+ms+excel&q=Scenarios&ved=2ahUKEwjI3eOgz92RAxV5zTgGHRCXO1cQgK4QegYIAQgAEAY
https://www.google.com/search?sourceid=chrome&nseg=what+if+analysis+in+ms+excel&q=Data+Tables&ved=2ahUKEwjI3eOgz92RAxV5zTgGHRCXO1cQgK4QegYIAQgAEAc
https://www.google.com/search?sourceid=chrome&nseg=what+if+analysis+in+ms+excel&q=Goal+Seek&ved=2ahUKEwjI3eOgz92RAxV5zTgGHRCXO1cQgK4QegYIAQgAEAg


Excel works backward to calculate the required value. 

Example 

• A student wants 75 total marks to pass. 

• Internal marks = 25 

• Goal: Find how many marks are needed in the final exam. 

Steps 

1. Go to Data → What-If Analysis → Goal Seek 

2. Set Cell → Result cell 

3. To Value → Desired result (75) 

4. By Changing Cell → Input cell (exam marks) 

Use 

• Finding required marks 

• Required profit 

• Required sales or percentage 

2. Scenario Manager 

Scenario Manager is used to compare multiple situations 

(scenarios) using different input values. 

Each scenario shows a different possible outcome. 

Example 

A business compares: 

• Best Case – High sales, low expenses 

• Worst Case – Low sales, high expenses 

• Average Case – Normal sales and expenses 

Excel displays results for all scenarios. 

Steps 

1. Go to Data → What-If Analysis → Scenario Manager 

2. Click Add 

3. Enter scenario name 



4. Enter changing values 

5. Click Show to view results 

Use 

• Business planning 

• Budget analysis 

• Salary calculations. 

3. Data Tables 

Data Tables show how changing one or two input values affects 

the result at the same time. 

Types 

• One-Variable Data Table 

• Two-Variable Data Table 

Example 

• Changing interest rate 

• Changing loan period 

• Viewing different EMI values 

Use 

• Loan calculations 

• Interest and EMI comparison 

• Profit and cost analysis 

 

Charts and Dashboards:- 

Charts and Dashboards are important data analysis and visualization 

tools used in MS Excel to present large amounts of data in a clear, 

visual, and meaningful way. They help users understand trends, 

comparisons, and performance quickly and support effective decision 

making. 

 

 



1. Charts 

A chart is a visual representation of data. Instead of reading 

numbers in rows and columns, charts show data in the form of bars, 

lines, or slices, which makes understanding faster and easier. 

Why Charts are Used 

• To compare values easily 

• To identify trends and patterns 

• To present data clearly 

• To make reports attractive 

Common Types of Charts 

• Column Chart – Used for comparing values (e.g., student marks) 

• Bar Chart – Horizontal comparison 

• Line Chart – Shows growth or trend over time 

• Pie Chart – Shows percentage or share 

Example: 

A column chart showing marks of students in different subjects. 

2. Dashboards 

A dashboard is a single screen or page that shows important 

information, charts, and summaries together. 

Dashboard = Multiple charts + key data on one screen 

Why Dashboards are Important 

• Gives a quick overview of data 

• Helps in decision making 

• Saves time 

• Easy to monitor performance 

Example: 

A college dashboard showing: 

• Total students 

• Pass percentage 



• Subject-wise results 

• Top performers 

3. Interactive Dashboards 

An interactive dashboard allows users to change or filter data and 

see updated results instantly. 

How Interactivity is Added 

• Using Pivot Tables 

• Using Pivot Charts 

• Using Slicers 

Steps to Create an Interactive Dashboard 

1. Prepare clean data 

2. Create Pivot Tables 

3. Insert Pivot Charts 

4. Add Slicers 

5. Arrange charts neatly on one worksheet 

When slicers are used, all charts update automatically. 

4. Using Slicers with Pivot Tables 

Slicer is a visual filtering tool used in MS Excel with Pivot Tables, 

Pivot Charts, and Tables. It allows users to filter data by clicking 

buttons instead of using drop-down menus. Slicers make data analysis 

faster, interactive, and easy to understand, especially in dashboards and 

reports. 

Why Slicers are Used 

• Easy and fast filtering 

• User-friendly 

• Improves dashboard interaction 

Example 

If a slicer has subjects: 

• Python 



• Java 

• Django 

Clicking “Python” will show only Python data in the Pivot Table and 

charts. 

5. Combo Charts 

Combo Charts (Combination Charts) in MS Excel are charts that 

combine two different chart types into a single chart. They are used when 

we want to compare different kinds of data or data with different scales 

together. For example, we can show sales using a column chart and 

profit using a line chart in the same graph. Combo charts make data 

comparison easier and help in better data visualization. 

Why Combo Charts are Used 

• To compare two related values 

• To show data and trend together 

Example: 

• Column chart shows Sales 

• Line chart shows Profit 

This makes comparison very easy. 

6. Sparklines 

Sparklines are small, simple charts that are placed inside a single cell in 

MS Excel. They are used to show trends and patterns in data in a 

compact and easy-to-understand visual form. Unlike normal charts, 

sparklines do not have axes, labels, or legends. They are mainly used in 

reports and dashboards to give a quick visual summary of data and help 

users understand changes over time at a glance. 

Types of Sparklines 

• Line Sparkline – Shows trend 

• Column Sparkline – Shows variation 

• Win/Loss Sparkline – Shows positive or negative values 

Why Sparklines are Used 

• Save space 



• Show trends quickly 

• Useful in reports and dashboards 

Example: 

Showing monthly performance of a student inside one cell. 

7. Advantages of Charts and Dashboards 

• Easy to understand large data 

• Quick decision making 

• Attractive presentation 

• Interactive and user-friendly 

• Saves time and effort 

Productivity Tips in MS Excel:- 

Productivity tips in MS Excel help users work faster, more accurately, 

and efficiently. Features like Named Ranges, Freeze Panes, and 

Split View are very useful when working with large datasets. These 

tools reduce errors, improve readability, and make data analysis easier. 

They are commonly used in offices, education, accounting, and data 

analysis tasks. 

1. Named Ranges 

A Named Range in Excel allows users to give a meaningful name to a 

cell or a range of cells instead of using cell references like A1:B10. This 

makes formulas easier to understand and reduces confusion. 

• Assigns names to cells or ranges 

• Makes formulas simple and readable 

• Reduces formula errors 

• Easy to use in functions and charts 

• Useful in large worksheets 

Example: 

Instead of =SUM(A1:A10), use =SUM(Sales) 

 

 



2. Freeze Panes 

Freeze Panes is used to lock specific rows or columns so that they 

remain visible while scrolling through large worksheets. It helps in 

viewing headings or important labels at all times. 

• Keeps rows or columns visible 

• Useful for large data tables 

• Commonly used to freeze header rows 

• Improves data readability 

• Saves time while scrolling 

Types: 

• Freeze Top Row 

• Freeze First Column 

• Freeze Panes (custom) 

3. Split View 

Split View divides the worksheet into two or four panes, allowing users 

to view different parts of the same worksheet at the same time. This is 

helpful when comparing data from different sections. 

• Splits worksheet into multiple panes 

• Helps compare distant data 

• Allows independent scrolling 

• Useful for analysis and checking data 

• Easy to enable and disable 

Differences between Named Ranges, Freeze Panes, and Split 

View:- 

Feature Named Ranges Freeze Panes Split View 

Meaning Gives a name to 

a cell or range of 

cells 

Locks selected 

rows or columns 

Divides worksheet 

into multiple panes 

Purpose Simplifies 

formulas and 

references 

Keeps headings 

visible while 

scrolling 

View different parts 

of same sheet 



Main Use Used in formulas 

and functions 

Used for large 

data tables 

Used for comparison 

and analysis 

Effect on 

Data 

Does not change 

data 

Does not change 

data 

Does not change 

data 

Scrolling Normal scrolling Frozen 

rows/columns 

stay fixed 

Each pane scrolls 

independently 

Visibility Improves 

formula 

readability 

Improves data 

readability 

Improves data 

comparison 

Example =SUM(Sales) Freezing top row Comparing top and 

bottom data 

Common 

Usage 

Formulas, charts Reports, mark 

sheets 

Analysis, checking 

data 

 

 

 


